Table of Contents

Preface ........................................................................................................................................... 3
Features ......................................................................................................................................... 4
Installation .................................................................................................................................... 5
Quick Start Guide .......................................................................................................................... 6
Copyright Notice ............................................................................................................................ 14

Changelog:

v1.4
Better documentation of Keyboard and XBox Controller
When OSD menu pressed, switch the stream to HD
PTZ Motion Sync On/Off
Status Bar (P, T, Z, Iris, Shutter Speed, Serial Number, Device Name)
Ability to call and set presets beyond 9 (Preset Setting Menu and Dialog)
Clear presets and images (Preset Setting Menu and Dialog)
New TV Icon next to the logo for opening the preview screen
Preset recall speed option
Removed selecting cameras using XBOX Controller
Make the preset images larger (Preset Setting Menu and Dialog)

v1.3
Support for new USB cameras (HuddleCamHD EPTZ cameras)
New Xbox controller explanation area
General bug fixes

v1.2
Ability to set Pan & Tilt Limits
Ability to take a camera snapshot from preview mode
Full documentation of Xbox controller functionalities in the application
Ability to choose if you want to store exposure information with each PTZ preset
Option to control speeds between PTZ presets
Focus Lock & Focus Unlock
App now retrieves Serial Number and Camera Info
Preset Hotkeys have been added
Preface
Thank you for downloading the PTZOptics PTZ Camera Controller. This application is available for Mac and Windows. It is also available for OBS (Open Broadcaster Software). The OBS plugin adds some additional features such as hotkeys support, but may not include all the functionality available in the main Windows and Mac applications.

Compatible Cameras
This software has been developed to control PTZOptics cameras.

- IP Control
  - All PTZOptics PTZ camera models
  - All PTZOptics ZCam camera models
- USB Control
  - All PTZOptics USB camera models
  - HuddleCamHD Pro and HuddleCamHD Pro IP

### Product Specifications

| Supported OS     | Windows 10 32bit/64bit  
| Mac OS - Catalina and later |
| Recommended Computer Specifications | CPU: Core i5 and above  
| Memory: 4GB and above  
| Display: 1280 x 960 and above (1920 x 1080 and above is recommended) |
| Supported Cameras | PT12X-ZCAM, PT20X-ZCAM, PT12X-SDI-xx-G2,  
| PT20X-SDI-xx-G2, PT30X-SDI-xx-G2, PT12X-USB-xx-G2,  
| PT20X-USB-xx-G2, (NDI Models also supported) |
| Supported Devices | Most USB connected Xbox Joysticks work including:  
| Microsoft Xbox 360 Controller, Power A (Model 1414135-02),  
| AmazonBasics Xbox USB joystick (Model 1500890-01) |
| Display Resolutions | 1280x720p, 1920x1080p |

Note
Please update the firmware of your PTZOptics camera to ensure all features of this software operate properly. You can confirm that your camera has the latest firmware at ptzoptics.com/firmware-finder.
Features

- Control up to 8 PTZOptics cameras over an IP connection (LAN) or USB
- Live Video Preview Mode with automatic camera switching
- Set up to 9 camera presets with image snapshot storage
  - Save up to 6 presets with image snapshots
- Name each unique preset & capture image representations
- Pan, Tilt and Zoom Speeds
  - Pan & Tilt Speed Locks
- Iris Controls
- Focus Controls (With Focus Speed)
- Selectable exposure modes (Auto, Manual, SAE, AAE and Brightness)
- Advanced image controls for Contrast, Luminance, Hue and Exposure
- Select between exposure modes
- Flip and Mirror camera image
- On-Screen Display Controls
- Real-time reporting of camera options status
- xBox Joystick Controller Support (Windows Only)
- Compact, Advanced and Preview Modes
- Full-Screen Camera Preview Modes (SD & HD Options for bandwidth conservation) (Windows Only)
- Ability to snap and unsnap preview mode to main application
- Ability to take a camera snapshot from preview mode
- Ability to choose if you want to store exposure information with each PTZ preset
- Option to control speeds between PTZ presets
- App now retrieves Serial Number and Camera Info
- Preset Hotkeys
- Set Pan and Tilt Limits
Installation Process

Windows:

1. Download Application
2. Run Setup Wizard
3. Open application from Windows Search Bar

Mac:

1. Download Application
2. Move application from your “Downloads” folder into the “Applications” folder
3. When you click to open you may see a window that says “PTZOptics cannot be opened because the developer cannot be verified.”
4. Click the Apple Icon in your system menu and select “System Preferences.”
5. Here you can allow the PTZOptics application to be granted access for use.
6. After this your application can be launched anytime.

OBS (Open Broadcaster Software) Plugin:

Windows:

1. Unzip files and put folders on to your computer.
2. Copy all files into Main (C:) > Program Files (x86) > obs-studio > obs-plugins > 64bit
3. When prompted click “continue” in administrator mode

Mac:

1. Unzip files and put them on to your computer
2. Copy obs-ptzcontroller.so to OBS.app/Contents/Plugins
3. Copy SDL.framework to OBS.app/Contents/Frameworks
Quick Start Guide

Step 1. Download the software and launch installation wizard.

Step 2. Open Software. From the “Settings” dropdown menu, open the “Multi Camera Setting” area to enter your cameras into the software. This software can control up to 8 cameras. Each camera can be connected via an IP address or a USB connection. Enter the camera's name and connection information and click “Ok.”
Step 3. Use the camera select area to select a camera you would like to control. Once you click the button, you will gain control of your camera. You can use the Pan, Tilt, and Zoom functionalities. You can also set and recall presets. The first six presets will store images you can use to see where each preset is saved.
Step 4. Next you can open up a live preview window from the “Window” dropdown menu. Click “Preview Window” and the live video preview window will snap to the main control panel. In the live video preview window, you can choose to take a snapshot, start and stop video, return the camera to home, choose your video stream quality and snap/unsnap the video preview window from the control panel. When you unsnap the video preview window, you can drag the window into a second monitor and make it full screen.

Note: You can determine the snapshot path folder for the application in the “Settings” drop-down menu.
Step 5: You can view the application in compact mode, or open up an advanced settings view using the “View” drop-down menu. When you click the “Advanced View” you will gain access to control speeds, camera exposure settings, image settings and white balance options. You are also able to operate the camera’s OSD (On Screen Display) menu.
Step 6: Next, you can decide to set up a USB connected Xbox controller to control your camera. To do this, click “Additional Input Options” from the “Settings” drop-down menu. Here you can select a USB connected XBox controller. You can also enable hotkeys to control the camera from your keyboard. Below you will find an explanation of the Xbox controller button mapping and keyboard hotkeys.

Note: The OSD menu is only viewable on “Stream 1.”
Xbox Help

LT: Focus Out
LB: Zoom Out
TL: Show OSD Menu (HD only)
Y11: Connect to Camera 1
X11: Connect to Camera 2
Y12: Connect to Camera 3
X12: Connect to Camera 4
DPad-Y1: Move Up
DPad-X1: Move Right
DPad-Y2: Move Down
DPad-X2: Move Left
Back: OBS Menu Back

RT: Focus In
RB: Zoom In
A: Call Preset 1
X: Call Preset 2
Y: Call Preset 3
B: Auto/Manual Focus
TR: Move to Home
Y21: Move Up
X21: Move Right
Y22: Move Down
X22: Move Left
Start: OBS Menu Enter
**Step 7.** You can decide to enable a camera status bar at the bottom of the application. This status bar will show helpful information such as the camera's name and status.
Step 8. You can set up pan and tilt limits for your PTZOptics camera in the “Settings” menu. This is ideal for areas where you do not want the camera to move past a certain point. You can move the camera to the limits of where you the camera should move and click the “Apply” buttons to set the limits of your PTZ camera.

Step 9: You can set up an image preview map within the preview window to make it easier to recall up to 9 camera presets. Using the “Image Preview Map” tool under the “Settings” drop-down menu, you can upload images into the preview window and still see a live video preview in a picture in picture setup. For example, you can capture a panoramic view of your space and place clickable preset images inside of the map to make recalling presets that much easier.

To start, click the “File” button to upload an image into the preview area. Then click “Show/Hide Bounding Boxes.” These bounding boxes can contain little pictures of their presets area where the camera will move when clicked. You can drag the bounding boxes over your uploaded image to make it easier to recall presets with better perspective for camera operators in a scene.

You can start by moving the camera to the preset location you would like to save. Then, select the preset 1-9, give the preset a name and click “Set Preset.” Before moving the camera you can also click “Take a snapshot” to load a snapshot into the bounding box. You can repeat the process for up to 9 bounding boxes. You can hide any bounding boxes you don’t need by clicking the box and selecting “Hide Current Bounding Box.”
Step 10: You can gain remote control of your PTZOptics cameras with a smartphone or tablet by enabling the Web Server. The Web Server is essentially a local area network IP address you can use to remotely control this application. When enabling the Web Server you can choose to “Start the web server upon launch”, “Enable OBS Control” or “Enable vMix Control.”
You can click the “copy” button to test this webserver with any web browser. Then you can enter it into a smartphone or table to control your cameras over WiFi.

**Web Server Menu:**

The Webserver includes a menu that you can use to switch between various views. Full View will

![Web Server Menu](image)

**Enabling OBS Controls:**

OBS controls allow you to control volume, start/stop streaming and recordings. In order to use OBS controls you must have the plugin “WebSockets Server” installed. You must enable Websockets server, set up a port, and a password. Once this is done you will need to click the “settings cog” in order to enter this information into the web-server interface. Then you can click the refresh button to start seeing the sources you have access to use and transition with.

**Taking Camera Snapshots:**

You can save images from your camera on to your computer's harddrive using the “Take a Snapshot” button.
The location that the image is stored will show up briefly on your preview screen. You can change where the images are stored in the settings menu by clicking “Snapshot path.”

**Real Time Status Bar:**

The status bar can be enabled in the View menu by clicking “Status Bar.” The status bar includes reporting on pan, tilt and zoom information along with focus, iris, and brightness. It’s also an easy way to retrieve the camera's model number and serial number.

**Adding Presets:**

The compact view of this application allows users to call up to 9 presets. If you have more presets you can
14 **Copyright Notice**

The entire contents of this manual, whose copyright belongs to PTZOptics, may not be cloned, copied, or translated in any way without the explicit permission of the company. Product specifications and information referred to in this document are for reference only and, as such, are subject to updating at any time without prior notice.